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Kit Contents
 Cap 

Color
 Reagents 12 

tests
24 

tests
48 

tests 

1 BROWN CMV  Mix A 242 μl 374 μl 638 μl

2 YELLOWYELLOW CMV  Mix B 198 μl 306 μl 522 μl

3 BLUE CMV Internal Control 1 tube 1 tube 1 tube

4 RED CMV Quantification Standard 1 (107 IU/ml) 1 tube 1 tube 1 tube

5 RED CMV Quantification Standard 2 (106 IU/ml) 1 tube 1 tube 1 tube

6 RED CMV Quantification Standard 3 (105 IU/ml) 1 tube 1 tube 1 tube

7 RED CMV Quantification Standard 4 (104 IU/ml) 1 tube 1 tube 1 tube

8 WHITE PCR Grade Water 1 tube 1 tube 1 tube

Storage
All reagents of RTA CMV Real-Time PCR Kit should be stored at -20°C. Storage at higher temperatures should 

be avoided (e.g. +4°C). Under these conditions, kit contents should be stable through the expiration date printed 

on the label.  The reagents should not be freeze-thawed more than 2 times; otherwise the shelf of the kit will 

reduce. During the working steps all reagents should be kept on ice. 



Intended 
Use

RTA CMV Real-Time PCR Kit is an in vitro nucleic acid amplification assay for quantification of Cytomegalovirus 

(CMV) DNA in human serum or plasma (EDTA) using RTA VOLTRAN Viral Load Detection System (HAMILTON 

Microlab STARlet IVD and BIO-RAD CFX96-IVD Real-Time PCR Detection System).  RTA CMV Real-Time PCR 

Kit is intended for use as an aid in the management of patients with chronic CMV infection undergoing anti-viral 

therapy to assess response to treatment in conjunction with all relevant clinical and laboratory findings. RTA 

CMV Real-Time PCR Kit is not intended for screening of blood and blood products for the presence of CMV 

DNA or confirmation of the diagnosis of infection with CMV.
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Product Use 
Limitations

All reagents of the kit is for in vitro diagnostic use only.

RTA CMV Real-Time PCR Kit is not intended for screening of blood and blood products for the presence of CMV 

DNA or confirmation of the diagnosis of infection with CMV.

This kit has been validated for use with human serum or human plasma collected in EDTA anticoagulant. Test 

with other sample types may result in inaccurate results.

This kit has been validated for use with RTA VOLTRAN Viral Load Detection System (HAMILTON Microlab 

STARlet IVD and BIO-RAD CFX96-IVD Real-Time PCR Detection System). Using other instruments may 

adversely affect the performance characteristics of the kit.

This kit has been optimized for use with specific PCR plastic consumables listed under Additional Materials 

Required section of the Handbook. Using other PCR plastic consumables may adversely affect the performance 

characteristics of the kit. 

Trustworthy results depends on proper sample collection, transport, storage and processing methods.

It is intended for professional use by properly trained personnel. 

RTA CMV Real-Time PCR Kit is  intended for use as an aid in the management of patients with chronic CMV 

infection undergoing anti-viral therapy to assess response to treatment in conjunction with all relevant clinical 

and laboratory findings.

The instructions in user manual should be followed strictly for optimum PCR results.

The expired kits should not be used. Kit components from different lots should not be mixed.



RTA CMV real-time PCR assay is a fluorogenic probe-based PCR assay in which, situated between two PCR 

primers, there is an internal oligonucleotide probe with a fluorescent label attached at the 5'-end and a 

quenching molecule that suppresses the fluorescent reporter at the 3'-end. During DNA replication in the PCR 

process, the internal oligonucleotide hybridizes to the template and is digested by the 5'-3' endonuclease 

activity of the Thermus aquaticus (Taq) DNA polymerase as the PCR primer is extended. The internal 

oligonucleotide is digested only if DNA replication occurs, separating the fluorescent and quencher molecules. 

PCR products are detected within minutes by monitoring the increase in fluorescence that occurs exponentially 

with successive PCR amplification cycles.  The parameter Ct (threshold cycle) is defined as the fractional cycle 

number at which the fluorescence passes the fixed threshold. A plot of the log of initial target copy number for a 

set of standards versus Ct is a straight line. Quantification of the amount of target in unknown samples is 

accomplished by measuring Ct and using the standard curve to determine starting copy number. RTA CMV real-

time PCR assay utilizes external standards to gather quantitative results and includes an internal control, which 

controls for target isolation and amplification. CMV DNA concentration is noted in International Units/ml (IU/ml). 

If it is needed to convert to copies/ml, our conversion factor for RTA CMV Real-Time PCR Kit is 0.92 copies/IU. 

In other words, 1 IU/ml = 0.92 copies/ml.

Product 
Description
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Pathogen 
Information

Cytomegaloviruses (CMVs) belong to the betaherpesviruses subfamily of herpesviruses and are ubiquitous but 

highly species-specific viruses that infect many animals, including humans. Infection with CMV is common in all 

populations and rarely associated with symptomatic infection in normal hosts. In contrast, it is a major cause of 

multiorgan disease in immunocompromised patients. CMV is also a leading cause of congenital infection and a 

leading infectious cause of brain disease and hearing loss in children in the United States and western Europe. 

As with other herpesviruses, primary infection with CMV is followed by a persistent infection (1). 

CMV is morphologically similar to other herpesviruses and is the largest member of the family. The virus 

consists of a 64-nm core enclosed by a 110-nm icosahedral capsid. The capsid is surrounded by a poorly 

defined amorphous tegument that itself is surrounded by a loosely applied, lipid-containing tegument (2). The 

genome of CMV consists of linear double-stranded deoxyribonucleic acid (DNA) molecule approx 240 kb. The 

genome of CMV is similar to that of herpes simplex virus in that it has long and short unique segments, both of 

which are bounded by homologous repetitive sequences. The CMV genome is approx 50% larger than herpes 

simplex virus and encodes for at least 35 structural proteins and an undefined number of nonstructural proteins 

(3). Although the replication of CMV is very similar to that described for herpes simplex virus, the replicative 

cycle is much slower than for herpes simplex (4).

References
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3.Sarov I, Abady I. The morphogenesis of human cytomegalovirus. Isolation and polypeptide characterization of

cytomegalovirus and dense bodies. Virology 1975;66:464–473.

4.Honess RW, Roizman B. Regulation of herpesvirus macromolecular synthesis. I. Cascade regulation of the

synthesis of three groups of viral proteins. J Virol 1974;14:8–19.



Warnings and 
Precautions
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All clinical specimens and all resulting waste materials should be treated as potentially infectious; the samples 

should be prepared in Bio-safety Level 2 area . 

Before and after work all surfaces should be disinfected with a freshly prepared solution of 10% bleach or 

antiviral agents.

Dispose of unused reagents, waste and specimens in accordance with country or local regulations.

Do not pipette by mouth.

Do not eat, drink or smoke in laboratory work areas.

Wear protective disposable gloves, laboratory coats and eye-wear when handling clinical specimens and kit 

reagents. Wash hands thoroughly after handling specimens and test reagents.

Avoid contact of reagents with the skin, eyes or mucous membranes. If contact does occur, immediately wash 

with large amounts of water,

Use all pipetting devices and instruments with care and follow the manufacturer’s

instructions for calibration and quality control; to prevent sample contamination, use new, sterile aerosol barrier 

or positive displacement RNase-free pipette tips and sterile pipettes

Handle all materials containing specimens or controls according to Good Laboratory Practices in order to 

prevent cross-contamination of specimens or controls.

Store the kit away from any source of contaminating DNA, especially amplified nucleic acid.

Do not mix reagents with different lot numbers or substitute reagents from other manufacturers.

A single type of CMV DNA assay should be used for monitoring a patient. If RTA CMV Real-Time PCR Kit 

substitutes another CMV DNA assay, both tests should be used in parallel for at least two subsequent samples.  

Do not use a kit after its expiration date.
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Additional 
Materials 
Required

● RTA VOLTRAN Viral Load Detection System components:

●HAMILTON Microlab STARlet IVD (Cat. No:185011)

●BIO-RAD CFX96-IVD Real-Time PCR Detection System (Cat. No:1855095-IVD)

●RTA MB Viral Nucleic Acid Isolation Kit (Cat. No: 090150XX)

●HAMILTON High Vol. (1mL) CO-RE Tips, Filtered 1000ul tips with filters (Cat. No:235905)

●HAMILTON Std. Vol. (300uL) CO-RE Tips, Filtered 300ul tips with filters (Cat. No:235903)

●HAMILTON DEEP WELL PLATE PP 2.2ML BC (Cat. No:235656)

●HAMILTON Reagent Containers, 60ML (Cat. No:194051)

●HAMILTON Reagent Containers, 2000ML (Cat. No:56695-01)

●BIO-RAD Hard-Shell Thin-Wall 96-Well Skirted PCR Plates with Bar Codes (Cat. No:HSP-9955)

●BIO-RAD Microseal 'B' Adhesive Seals, optically clear (Cat. No:MSB-1001)

● Disposable powder-free gloves

● Micropipettes (0.5 µl – 1000 µl)

● Sterile micropipette  tips with filters

● Vortex mixer

● Desktop microcentrifuge for 2.0 ml tubes and for PCR plates



Sample 
Preparation

This kit has been validated for use with human serum or human plasma collected in EDTA anticoagulant.

Aseptic techniques must be employed during collection to prevent the introduction of micro-organisms into the 

patient’s anatomical space, and to prevent the sample from being contaminated during the process of collection.

All samples should be regarded as potentially infectious and standard precautions guidelines should be followed 

by all healthcare workers during sample collection and handling.

Samples must be collected into appropriate containers before despatch to the laboratory. Formats accepted are 

4ml and 6ml Vacutainers (BD #368861 and #367864) or similar tubes that do have the same inner dimensions 

as these two tubes (round-bottom and inner diameter).

Be careful to check for cracks in the containers and to ensure that the lids of containers are properly tightened 

to prevent leakage of samples during handling and transportation. This can pose infection hazards to transport 

and laboratory staff.

Ensure that the outer surfaces of the containers are not contaminated by the patients’ samples.

Store whole blood at room temperature  for no longer than 4 hours. Centrifuge blood within 4 hours of collection. 

Transportation of whole blood, serum or plasma must conform to country or local regulations for the transport of 

etiologic agents.

Serum or plasma samples may be stored at 2-8°C for up to 3 days or frozen at -70°C or

colder for long-term storage.

Avoid multiple freeze/thaw cycles of specimens.
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Protocol Viral DNA Isolation 

RTA VOLTRAN Viral Load Detection System should be used together with RTA MB Viral Nucleic Acid Isolation 
Kit (Cat. No: 090150XX) for viral DNA extraction from clinical samples. Starting sample volumes were 200 μl and 
elution volumes were 50 μl. Please follow the manufacturer’s instructions as stated in RTA VOLTRAN Viral Load 
Detection System Handbook.

 Internal Control 

During DNA isolation, addition of the supplied internal control (IC) is necessary. IC allows the user to monitor 
DNA extraction step as well as to determine any PCR inhibition. There was no amplification of internal control in 
the tests where  high positive CMV samples were amplified because there was a competition between internal 
control template and CMV DNA template for using PCR primers and other components. The Ct value of internal 
control of a negative sample should be equal to 33 ± 5, otherwise,it denotes a problem during purification.

Quantification Standards

For generating a standard curve to obtain accurate quantification data on the Real-Time system, four 
quantification standards should be used. For each standard the corresponding concentration should be defined 
properly to the Real-Time PCR system before each run and the standard curve will be generated accordingly at 
the end of the reaction. 

Since starting sample volumes were 200 μl and elution volumes were 50 μl, the concentration factor is 4. If we 
define the corresponding concentration for each standard by dividing the original concentration by 8, the 
concentration of each positive sample will be automatically calculated by CFX Manager software. The 
concentrations of the standards are already defined either in plate file (.pltd extension) under Templates folder 
for manual programming or in LIMS file generated by HAMILTON Microlab STARlet IVD.

PCR Setup

RTA VOLTRAN Viral Load Detection System should be used together with RTA CMV Real-Time PCR Kit (Cat. 
No: 090140XX) for setting up PCR reactions. Four quantification standards and one negative control should be 
included for every run. Please follow the manufacturer’s instructions as stated in RTA VOLTRAN Viral Load 
Detection System Handbook.
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Protocol 
(continued)

Running Assay on BIO-RAD CFX96-IVD Real-Time PCR Detection System by Manual Programming

Close the PCR plate with BIO-RAD Microseal 'B' Adhesive Seal, and place it in the 96-well block. Close the lid.
The Startup Wizard automatically appears when Bio-Rad CFX Manager software is first opened. If it is not 
shown, click the Startup Wizard button on the main software window toolbar. Click User-defined option in the 
Startup Wizard (Figure 1).

Figure 1. Startup Wizard window.
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Protocol 
(continued) Click the Protocol tab and then click the Select Existing tab to select RTA CMV Real-Time PCR Kit protocol file 

(.prcl extension) under Templates folder to run (Figure 2).

Figure 2. Protocol selection window.
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Protocol 
(continued) Then click the Plate tab and then click the Select Existing tab to select RTA CMV Real-Time PCR Kit plate file 

(.pltd extension) under Templates folder to load. Then edit the plate according to the test number and sample 
information by clicking Edit Selected option (Figure 3).

Figure 3. Plate selection window.
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Protocol 
(continued) Click the Start Run tab and then click the Start Run button to begin the experiment.(Figure 4).

Figure 4. Start Run window.
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Protocol 
(continued)

Running Assay on BIO-RAD CFX96-IVD Real-Time PCR Detection System by LIMS Integration

CFX Manager software can be configured for use with a Laboratory Information Management System (LIMS). 
For LIMS integration, CFX Manager software requires plate setup information generated by HAMILTON Microlab 
STARlet IVD (a LIMS file, *.plrn), a protocol file created using CFX Manager software (*.prcl), a defined data 
export location, and a defined export format.

Setting up LIMS Folder and Data Export Options
1. Select Tools > Options from the main software menu bar then select the LIMS tab (Figure 5) to define the 
folder location that will contain the LIMS protocol (*.prcl), LIMS file (*.plrn), and exported data.

Figure 5. Options window displaying the LIMS settings tab.
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Protocol 
(continued)

2. At run completion, a LIMS data export file can be automatically generated in addition to the CFX Manager 

software *.pcrd data file. Check the Automatically Export Data after Run (Figure 5) box to have the data 

exported automatically once a run is completed.

3. Click the Data Export Settings button to specify the file format to be used for the exported data and which 
information fields will be exported (Figure 6).

Figure 6. LIMS Data Export Format Settings window.
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Protocol 
(continued)

Creating a LIMS Protocol

To start a LIMS run, a CFX Manager software protocol file (*.prcl) must be created and saved in the designated 

LIMS protocol folder location specified in the LIMS tab of the Options window.

Creating a LIMS File

A LIMS file (*.plrn) contains the plate setup details and the protocol file name. This file is generated by 

HAMILTON Microlab STARlet IVD (a LIMS file, *.plrn). CFX Manager software will use the LIMS file to create a 

plate file that will be used in conjunction with the named protocol file to start a run and generate data.
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Protocol 
(continued)

Initiating a LIMS Run
Close the PCR plate with BIO-RAD Microseal 'B' Adhesive Seal, and place it in the 96-well block. Close the lid.
To initiate a LIMS run:
1. Open a LIMS file using one of the following methods:
• Drag and drop the .plrn file onto the CFX Manager software window or desktop icon
• Select Tools > LIMS File Folder from the main software window menu bar. Double-click on the desired .plrn 
file to open the run
• Select File > Open > LIMS file from the main software window menu bar. Select the .plrn file from the LIMS 
folder and click Open
2. To start the run for a selected LIMS file, select an instrument and click Start Run (Figure 7). The contents of 
the LIMS file and linked protocol file are used to complete the protocol and plate tabs.
Figure 7. Run Setup window with a LIMS run ready to start.
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Protocol 
(continued)

Exporting Data to a LIMS

Upon run completion, a CFX Manager software data (.pcrd) file is generated and saved to the defined data 

export folder location (Figure 5).

When Automatically Export Data after Run is selected in LIMS Options, a second data file compatible with 

LIMS data retrieval will be saved to the same location. The file format and contents are defined using LIMS Data 

Export Format settings. To export this data manually, select Export > Export to LIMS Folder from the main 

software window menu bar.
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Data Analysis To be able to evaluate the experiment, PCR efficiency of the Standard Curve must be between 90%-110% and R2 value

must be more than 0.98. Otherwise, the experiment should be repeated.The baseline threshold values are 500 for FAM 

and 250 for HEX. (In the laboratories that RTA VOLTRAN Viral Load Detection System is installed, FAM and HEX values 

are pre-adjusted on CFX Manager, user do not adjust manually). Then, the concentration of each sample will be 

calculated by the CFX Manager software according to the standard curve as International Unit per milliliter (IU/ml). If it is 

needed to convert the quantitative results from IU/ml to copies/ml, the conversion factor for RTA CMV Real-Time PCR Kit, 

version 2.0 is 0.92 copies/IU. In other words, 1 IU/ml = 0.92 copies/ml. The interpretation on the results given by the 

software can be done as follows:
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Signal 
detected
İn FAM 
channel

Signal 
detected
İn HEX 
channel

Quantitative result
from the software

Conclusion

+ + <58.5 IU/ml (54 

copies/ml)

The result is valid.
CMV DNA is detected at a concentration <58.5 IU/ml (54 copies/ml). 
Quantitation is not possible since the quantitative result is below the 
lower limit of the linear range of the assay. Reproducibility of the positive 
result is not guaranteed.

+ +/- ≥58.5 IU/ml (54 
copies/ml)

and
≤1 x 109 IU/ml (9.2 x 

108 copies/ml)

The result is valid.
CMV DNA is detected at the concentration calculated by the software 
since the quantitative result is within the linear range of the assay.

+ +/- >1 x 109 IU/ml (9.2 x 
108 copies/ml)

The result is valid.
CMV DNA is detected at a concentration >1 x 109 IU/ml (9.2 x 108 
copies/ml) copies/ml . Quantitation is not possible since the quantitative 
result is above the linear range of the assay.

- + N/A The result is valid.
Target (CMV DNA) is not detected.

- - N/A The result is invalid.
No diagnostic interpretation can be done.



Performance 
Characteristics

Analytical Sensitivity

Analytical sensitivity was analyzed by use of a dilution series of WHO standard, and the cutoff value of the kit 

was determined by probit analysis for BIO-RAD CFX96-IVD Real-Time PCR Detection System. A dilution series 

of a 1st WHO International Standard for Human Cytomegalovirus (NIBSC code: 09/162) was prepared to give 

the final concentrations of 640, 320, 160, 80, 40 and 20 IU/ml. Dilutions were extracted by RTA VOLTRAN Viral 

Load Detection System  according to the instructions written in the handbook. Starting sample volumes were 

200 µl and elution volumes were 50 µl. Each dilution was tested in 24 replicates. Lower limit was calculated by 

probit analysis done by PASW Statistics 18 program. RTA CMV Real-Time PCR Kit, version 2.0 can detect CMV 

DNA at concentration of 60 IU/ml (55 copies/ml) with a probability rate of 95 %. And, 95 % confidence range is 

48 – 98 IU/ml (44-90 copies/ml).
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Performance 
Characteristics
(continued)

Linear Range

To determine the upper limit, a dilution series of 1st WHO International Standard for Human Cytomegalovirus 

(NIBSC code: 09/162)  ranging from 1 x 103 IU/ml to 1 x 106  IU/ml were prepared.Viral DNA was extracted from 

standards by  RTA VOLTRAN Viral Load Detection System according to the instructions written in the handbook. 

Starting sample volumes were 200 µl and elution volumes were 50 µl. High concentration samples (1 x 107, 1 x 

108 and 1 x 109 IU/ml) were prepared by using calibrated plasmid DNA bearing CMV external standard. Within 

this range, the relationship between log of target DNA and Ct values is linear. Linear regression analyses 

comparing the Ct values-versus- log of target DNA  were as follows: 

Ct value = -3.711(log of target DNA) + 49.19; with a correlation coefficient (R2) of 0.998.

Upper limit is at least 1 x 109 IU/ml (9.2 x 108 copies/ml) for  BIO-RAD CFX96-IVD Real-Time PCR Detection 

System.

Lower limit was calculated by probit analysis done by PASW Statistics 18 program according to the 

quantification results of CMV Analytical Sensitivity Studies.  95 % lower confidence limit is 58,5  IU/ml (54 

copies/ml) for BIO-RAD CFX96-IVD Real-Time PCR Detection System. Dynamic range of RTA CMV Real-Time 

PCR Kit, version 2.0: 

58,5 - 1 x 109 IU/ml (54 - 9.2 x 108 copies/ml)
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Performance 
Characteristics
(continued)

Precision

For each experiment, 24 replicates of 105 IU/ml 1st WHO International Standard for Human Cytomegalovirus 
(NIBSC code: 09/162) were used.  Viral DNA was extracted from WHO standards by RTA VOLTRAN Viral Load 
Detection System  according to the instructions written in the handbook. The results on basis of Ct values are 
shown in the following table: 
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Descriptive Statistics

 N Mean Std. 
Deviation

Variance Coefficient of 
variation (%)

Intra_assay 24 28,7683 ,39119 ,153 1,36

Inter_assay 24 28,7900 ,38657 ,149 1,34

Inter_batch 24 28,7650 ,59478 ,354 2,06

INCEPTRA_Cycler_9660 24 28,5963 ,39745 ,158 1,39

BIO-RAD CFX96 24 29,3154 ,23626 ,056 0,80

TOTAL 120 28,8470 ,47786 ,228 1,65

Descriptive Statistics

 N Mean Std. 
Deviation

Variance Coefficient of 
variation (%)

Intra_assay 24 5.12 ,081 ,007 1,58

TOTAL 24 5.12 ,081 ,007 1,58



Performance 
Characteristics
(continued)

Diagnostic Specificity

CMV negative clinical specimens were analyzed to determine the diagnostic specificity of RTA CMV Real-Time 

PCR Kit, version 2.0. 60 CMV DNA negative clinical serum specimens and 60 CMV DNA negative clinical EDTA 

plasma specimens were used. Viral DNA was extracted from HBV negative clinical specimens  by RTA 

VOLTRAN Viral Load Detection System according to the instructions written in the handbook.

None of the 120 CMV negative clinical specimens gave positive test result for CMV DNA. Diagnostic specificity 

of RTA CMV Real-Time PCR Kit, version 2.0 is 100 %.  All of the Internal Controls of tests gave positive result. 
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Cross Reactivity

To examine the specificity of an assay, cross-reactivity studies should be performed for potential cross-reactive 

markers. In this study, the specificity  of the assay was evaluated  by  testing 8 reference organism and 10 

clinical specimens which were positive. RTA CMV Real-Time PCR Kit, version 2.0 do not show any cross-

reactivity with other potential cross-reactive markers given in the following table:



Performance 
Characteristics
(continued)

Potential cross-reactive markers tested in the study: 
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Organism Source Test Result

Hepatitis B virus (HBV) NIBSC (Cat. No: 97/750) Negative

Human Herpes Simplex virus type 1 (HSV-1) NIBSC (Cat. No: 08/224) Negative

Human Herpes Simplex virus type 2 (HSV-2) NIBSC (Cat. No: 08/226) Negative

Epstein-Barr Virus (EBV) NIBSC (Cat. No: 08/316) Negative

Hepatitis C virus (HCV) NIBSC (Cat. No: 06/100) Negative

Human Immunodeficiency Virus 1 (HIV-1) NIBSC (Cat. No: 97/650) Negative

Mycobacterium tuberculosis ATCC (25177) Negative

Human Immunodeficiency Virus 2 (HIV-2) NIBSC (Cat. No: 08/150) Negative

Hepatitis B virus (HBV) Clinical specimens Negative

Hepatitis B virus (HBV) Clinical specimens Negative

Hepatitis C virus (HCV) Clinical specimens Negative

Hepatitis C virus (HCV) Clinical specimens Negative

Human Immunodeficiency Virus 1 (HIV-1) Clinical specimens Negative

Human Immunodeficiency Virus 1 (HIV-1) Clinical specimens Negative

Parvovirus B19 Clinical specimens Negative

Epstein-Barr Virus (EBV) Clinical specimens Negative

Hepatitis D virus (HDV) Clinical specimens Negative

Human papillomavirus type 6 (HPV 6) Clinical specimens Negative



Performance 
Characteristics
(continued)

Cross-Contamination

In this study, cross-contamination between samples was evaluated. To do this, five different runs were 

performed. In every run, 4 high positive CMV sample and 4 CMV negative samples were used. Then, the kit was 

evaluated accordingly whether or not any  cross-contamination was observed.

No cross-contamination was observed during the whole process, and none of the human serum samples 

exhibited evidence of containing PCR inhibitors as indicated by the amplification of internal control.

Whole System Failure

60 CMV negative clinical serum specimens and 60 CMV DNA negative clinical EDTA plasma specimens were 

spiked with 1st WHO International Standard for Human Cytomegalovirus (NIBSC code: 09/162) to give a final 

concentrations of 180 IU/ml which is 3 times the 95% positive cutoff value determined by analytical sensitivity 

study. Spikes were extracted  by RTA VOLTRAN Viral Load Detection System according to the instructions 

written in the handbook. Whole  system  failure  rate of RTA CMV Real-Time PCR Kit, version 2.0 is ≤1 %.
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